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بسمه تعالی

»و من احیاها فکانّما احیا الناس جمیعا«  )مائده آیه ٢٣(

فرایند تولید برنامه درسی  مجموعه فعالیت های نظام مند و طرح ریزی شده ای است، که تلاش دارد ابعاد چهارگانه زیر نظام 
برنامه درسی )طراحی، تدوین، اجرا و ارزشیابی( را در یک فعالیت منسجم، هماهنگ با غایت و اهداف نظام تعلیم و تربیت رسمی 

سازماندهی نماید.
در تدوین محتوای کتب دانش آموزان با نیازهای ویژه که بخشی از فرایند برنامه ریزی درسی است، سعی شده تا ملاحظات 
ساحت های تربیتی حاکم بر فلسفه تعلیم و تربیت که ناظر بر رشد و توانمندی دانش آموزان برای درک و فهم دانش پایه و عمومی، 
و  خلاقیت  بروز  جهت  آمادگی  انتقادی،  تفکر  توان  منطقی،  و  علمی  تفکر  شیوه  به کارگیری  دانش افزایی،  مهارت های  کسب 
نوآوری و نیز کسب دانش، بینش و تفکر فناورانه برای بهبود کیفیت زندگی است، مورد توجه قرار گیرد. این محتوا با فراهم 
نمودن فرصت های مناسب برنامه درسی ضمن تأکید بر انعطاف در عین ثبات و همه جانبه نگری و توجه به هویت ویژه متربیان با 

نیازهای خاص، زمینه ساز دستیابی دانش آموزان به کسب شایستگی های لازم )توانمندی ها، مهارت ها( می باشد. 
امید است این محتوا در تحقق اهداف مؤثر باشد و معلمان عزیز و گرامی با بهره گیری از این کتاب بتوانند فراگیران را در 

دستیابی به صلاحیت های فردی و اجتماعی یاری نمایند.
این کار بزرگ حاصل همکاری صمیمانه کارشناسان سازمان آموزش و پرورش کودکان استثنایی و گروه های تألیف کتاب های 
درسی می باشد، شایسته است از تلاش و مساعی این عزیزان و همکاران سازمان پژوهش و برنامه ریزی آموزشی وزارت متبوع که 

در مراحل چاپ و آماده سازی ما را یاری داده اند، تقدیر و تشکر نماییم.
در اینجا از همه همکاران و صاحب نظران درخواست می نمایم، تا نظرات و پیشنهادهای خود را در خصوص این محتوا به 

این سازمان منعکس نماید.
دکتر مجید قدمی
معاون وزیر و رییس سازمان
آموزش و پرورش استثنایی کشور



سخنی با مرّبیان
 

از آن جا که آموزش‌های ارائه شده در یک نظام آموزشی می بایست مرتبط با نیازهای زندگی و شغلی آینده ی افراد 
باشد، این رسالت مهم به عهده ی آموزش وپرورش هر کشوری است تا آینده سازان کشور را برای جامعه آماده کند. 

با توجه به تأثیر روزافزون فناوری اطلاعات و ارتباطات در زندگی بشر،انسان عصر اطلاعات لازم است با ابعاد 
مختلف این علم آشنا شده و مهارت های ضروری کار با ابزار فناوری اطلاعات را کسب کند. بدین منظور کارشناسان و 

برنامه ریزان، تدوین درس »آموزش رایانه« را برای دانش آموزان با نیازهای ویژه ضروری دانستند.
دراین راستا کتاب حاضر با همکاری گروه درسی رایانه‌ی دفتر برنامه ریزی و تألیف کتب درسی عمومی و نظری 
دانش آموزان  از  گروه  این  اشتغال  توانمندی های لازم جهت  ایجاد  کتاب،  این  تألیف  اهداف  از  است. یکی  تألیف شده 

می باشد.
همکاران محترم در آموزش این کتاب باید به نکات زیر توجه نمایند:

1ــ با توجه به ماهیت عملی این درس، لازم است آموزش آن در کارگاه رایانه انجام پذیرد. 
2ــ هردرس برای یک جلسه ی آموزشی در نظرگرفته شده است و مشتمل بر تعدادی فعّالیّت آموزشی می‌باشد.

3ــ طراحی فعالیت ها به گونه ای است که دانش آموزان در حین انجام فعّالیّت، با نکات آموزشی مربوط به یک نرم 
افزار آشنا می شوند. 

4ــ نکات مهم هر درس در کادر مشخص شده اند که لازم است مربّی توجه دانش آموزان را به آن ها جلب نماید. 
5ــ به منظور تقویت یادگیری، مراحلی جهت تکرار فعّالیّت ها  درنظر گرفته شده است که لازم است توسط فراگیران 

انجام شود. 
6ــ در ارزشیابی از دانش آموزان، توانایی استفاده از یک روش برای انجام هر فعّالیّت کافی است.

7ــ ارزشیابی از این درس به صورت عملی انجام شود. 
داده  آموزش    Microsoft office  ٢٠٠٣ کاربردی  افزارهای  نرم  و   XP ویندوز  عامل  سیستم  کتاب،  دراین  8ــ 

می شود.
9ــ  همراه این کتاب، یک CD در اختیار مربّی قرار می گیرد که مربوط به بخش نرم افزار Power Point است. 
مربّی کلاس می تواند در اولین جلسه ی این بخش، با اجرای برنامه ی مربوطه و ارائه توضیحات کافی، انگیزه ی لازم را 

جهت به کارگیری این نرم افزار در دانش آموزان ایجاد کند. 
هم چنین یک بسته آموزشی شامل تعدادی کارت های تصویری تهیه شده است که می توانید جهت تحکیم و یادگیری 

از آن ها در کلاس درس استفاده کنید.
بدیهی است ارسال  نظرات وپیشنهادات مربیان محترم، موجب امتنان بوده و گروه تألیف را در جهت غنی‌تر شدن 

کتاب حاضر یاری می نماید. 



سخنی با دانش آموزان عزیز

امروزه نرم افزارهای متنوعی برای انجام امور مختلف وجود دارد .تحقیقات و تجربه نشان می دهد که تولید 
دانش توسط دانش آموز به جای انتقال دانش از معلم به دانش آموز،کارآمدتر و ماندگارتر است ،لذا بر انجام فعّالیّت ها 
توسط دانش آموزان تأکید بسیار شده است .با در نظر گرفتن این امر مهم،  مطالب آموزشی این کتاب در قالب فعّالیّت های 
کاربردی ارئه شده است .هدف از طراحی این نوع فعّالیّت ها، ایجاد انگیزه در به کارگیری مهارت های کسب شده در انجام 

فعّالیّت های روزمره ی، شما  دانش آموزان عزیز است.  
فعّالیّت های کاربردی، توانایی کار با سیستم عامل ویندوز و  در کتاب حاضر تلاش شده است تا  شما با انجام 

نرم افزارهای واژه پرداز Word و ارائه ی مطالب Power Point  را در حد نیاز کسب کنید.
 یادگیری مطالب این کتاب بی شک پایان راه نخواهد بود. ولی می تواند به شما دید لازم را برای انتخاب و تکمیل 
مهارت بدهد .یکی از سودمندترین مهارت هایی که می توانید کسب کنید، توانایی یادگیری به وسیله خودتان است و هرچه 

بیشتر یاد بگیرید، تواناتر خواهید بود. 



وضعیت صحیح بدن هنگام استفاده از رایانه

توصیه ها ومقرّرات حضور در کارگاه رایانه

در جلسات کارگاهی، لازم است دانش آموزان با مقرّرات حضور در کارگاه، نحوه ی صحیح به کارگیری تجهیزات 
و خطرات احتمالی آشنا شوند.

 هنگام کار مراقب کابل ها و پریزهای برق باشید. 	
 از چاپ غیر ضروری و به هدر دادن کاغذ خودداری کنید. 	

 قبل از قرار دادن CD یا فلاپی در رایانه، با مربّی خود هماهنگی به عمل آورید.  	
 بعد از اتمام کار خود، رایانه را خاموش)Shut Down(  کنید. 	

 قبل از ترک کردن کارگاه، میز رایانه و محیط کارگاه را مرتب نمایید.  		
 در حفظ و نگه داری تجهیزات سخت افزاری و نرم افزار ی کارگاه بکوشید.    		
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ـ تغییر نام فایل	 فعّالیّت 1: کپی کردن فایل ازی ک پوشه به پوشه ی دیگر )   Copy -Paste ( ـ
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فهرست مطالب
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١

درس اول

کار با ويندوز (۱) 

فعّاليّت ۱ (يادآوری): شناسايی آيکون های Desktop، ايجاد پوشه، اجرای برنامه، ذخيره ی فايل  
۱ــ رايانه را روشن کنيد.

۲ــ چه آيکون هايی را روی Desktop مشاهده می کنيد؟ نام کدام آيکون را می دانيد؟ 

۳ــ پنجره ی My Documents را باز کنيد. 
۴ــ يک پوشه به نام class در آن ايجاد کنيد. 

۵ــ پنجره ی My Documents را ببنديد. 
۶ــ برنامه ی  paint را از مسير زير اجرا کنيد: 

Start → All programs → Accessories → paint                                            



٢

۷ــ در صفحه ی سفيد paint يک نقاشی به دلخواه بکشيد. 

نکته: 
 My Pictures فايل های تصويری که شما ايجاد می کنيد، هنگام ذخيره کردن به طور پيش فرض در پوشه ی • 

ذخيره می شوند. شما می توانيد محل ذخيره ی فايل را به دلخواه خود تغيير دهيد.

٨   ــ فايل خود را به نام «نقاشی » در پوشه ی My Documents ذخيره کنيد. 
٩ــ از منوی فايل گزينه ی Save As را انتخاب کنيد.



٣

١٠ــ روی علامت  در کادر Save in  کليک کنيد.

۱ــ مربی کارگاه، شيوه ی نمايش آيکون ها را به يکی از شکل های Tiles ،Thumbnails يا Icons قرار دهد. 

١١ــ پوشه ی My Documents را انتخاب کنيد.
١٢ــ در کادر file name نام فايل (نقاشی) را تايپ کنيد.

١٣ــ روی دکمه ی Save کليک کنيد.
File → Save As → File Name:     نقاشی     → Save

١٤ــ پنجره ی  paint را ببنديد.   
 

  My My ComputerComputer  فعّاليّت فعّاليّت ۲۲: شناسايی آيکون های پنجره ی: شناسايی آيکون های پنجره ی
می خواهيم در پنجره ی My Computer مشخص کنيم که هر آيکون مربوط به چيست.

روش کار:
۱ــ روی آيکون My Computer در Desktop دوبار کليک کنيد تا پنجره ی آن باز شود. 

۲ــ به شکل آيکون ها توجه کنيد.١



٤

نکته: 
• آيکون     مربوط به فلاپی است. 

• آيکون    مربوط به CD است. 

• معمولاً ديسک سخت (Hard Disk) را به چند قسمت تقسيم می کنند؛ به هريک از اين قسمت ها 

«پارتيشن» يا «درايو»  گفته می شود، که با حروف  (:C) ، (:D) , ... و    با آيکون    مشخص 

می شود.

۳ــ آيکون مربوط به فلاپی و CD را نشان دهيد. 
۴ــ آيکون مربوط به درايو C و D را نشان دهيد. 



٥

درس دوم

کار با ويندوز (٢) 

فعّاليّت ۱: کپی کردن فايل از يک پوشه به پوشه ی ديگر (copy _ paste)، تغيير نام فايل 
فايل «نقاشی» را از پوشه ی My Documents  در پوشه ی  class  کپی کنيد. 

نکته:
• همان طور كه می دانيد برای دسته بندی اطلاعات درحافظه ی رايانه، آن ها را در پوشه قرار می دهيم.

منتقل  آن  به  يا  و  كپی كرده  ديگری  پوشه ی  در  پوشه،  يک  از  را  خود  مورد  نظر  فايل های  می توانيد  شما   •
كنيد.  

روش کار 
۱ــ پنجره ی My Documents را بازکنيد. 

۲ــ روی فايل «نقاشی» يک بار کليک کنيد تا انتخاب شود. 
۳ــ روی کلمه ی Edit در بالای پنجره کليک کنيد تا منوی آن باز شود. 

۴ــ در منوی ظاهر شده روی گزينه ی copy کليک کنيد. 



٦

۵ــ روی پوشه ی class  دوبار کليک کنيد تا باز شود.

۶ــ روی کلمه ی Edit در بالای پنجره کليک کنيد تا منوی آن باز شود. 
۷ــ در منوی ظاهر شده روی گزينه ی paste کليک کنيد. 

به اين ترتيب فايل «نقاشی» در داخل پوشه ی class کپی می شود. 



٧٧٧

«طراحی»  به  را  «نقاشی»  فايل  نام  ۸  ــ 
تغيير نام دهيد. 

برای اين کار فايل« نقاشی» را انتخاب 
گزينه ی   روی   File منوی  در  سپس  کنيد؛ 
طراحی»   » کلمه ی  و  کرده  کليک   Rename

را تايپ کنيد.
(File → Rename → طراحی) 

نكته
هنگام تغيير نام فايل توجه داشته باشيد پسوند فايل تغيير نكند.



٨

(cut ــ paste) فعّاليّت ۲: انتقال فايل از يک پوشه به پوشه ی ديگر 

پوشه ای به نام «مدرسه» در درايو D ايجاد کنيد و فايل « طراحی» را از پوشه ی My Documents به داخل پوشه ی 
«مدرسه» منتقل کنيد. 

روش کار 
۱ــ پوشه ی My computer را باز کنيد. 

۲ــ روی درايو D دو بار کليک کنيد تا پنجره ی آن باز شود. 



٩

۳ــ روی کلمه ی File دربالای پنجره کليک کنيد تا منوی آن باز شود. 
انتخاب  را   Folder آن،  گزينه ی  به  مربوط  منوی  در  و  کنيد  کليک   New گزينه ی  روی  ظاهرشده  منوی  در  ۴ــ 

کنيد. 



١٠

۵ــ نام پوشه ی ايجادشده را «مدرسه» بگذاريد. 

(برای تايپ فارسی، کليد های Alt و  Shift صفحه کليد را هم زمان با هم فشار دهيد.)
۶ــ با کليک روی علامت    در بالای پنجره ی درايو D، پنجره را به پائين صفحه منتقل می شود. 

۷ــ پوشه ی My Documents را باز کنيد. 
۸ــ فايل «طراحی» را انتخاب کنيد.

۹ــ روی کلمه ی Edit در بالای پنجره کليک کنيد تا منوی آن باز شود. 
۱۰ــ در منوی Edit روی گزينه ی Cut کليک کنيد. 



١١

۱۱ــ برای اين که بتوانيد پنجره ی مربوط به درايو D را دوباره مشاهده کنيد، در نوارپايين صفحه ی Desktop روی 
دکمه ی مربوط به آن کليک کنيد. 

۱۲ــ روی پوشه ی «مدرسه» دوبارکليک کنيد تا باز شود. 
۱۳ــ در منوی  Edit روی گزينه ی Paste کليک کنيد. 



١٢

به اين ترتيب فايل «طراحی» از پوشه ی My Documents به پوشه ی «مدرسه» منتقل می شود. 



١٣

۱ــ يک پوشه به نام Tamrin در  درايو D ايجاد کنيد. 

۲ــ از درايوD پوشه ی«مدرسه» را بازکنيد و فايل «طراحی» را به داخل پوشه ی Tamrin منتقل کنيد. 

۳ــ پوشه ی «مدرسه» را حذف کنيد. 

۴ــ محتوای Recycle Bin را خالی کنيد. 

استفاده   Shift و   Alt کليد  از  تغييرزبان  (برای  دهيد.  تغيير  به «تمرين»،  را   tamrin پوشه ی  نام  ۵ــ 
کنيد.) 

ايجاد کنيد.  D در  درايو Tamrin هــ يک پوشه به نام شه ک ۱۱



١٤

ميانبر  يک  می توانيد  داريد،  کار  و  سر  آن ها  با  بيشتر  که  برنامه هايی  يا  فايل ها  پوشه ها،  به  سريع تر  دسترسی  برای 
(Short  cut)  روی Desktop ايجاد کنيد که اين ميانبر ،کپی آيکون آن است.

 
  (Short cut) فعّاليّت ۱: ايجاد ميانبر

برای برنامه ی Calculator (ماشين حساب) يک short  cut روی Desktop ايجادکنيد. 
روش کار: 

۱ــ روی دکمه ی Start کليک کنيد. 
۲ــ نشانگر ماوس را روی All Programs قراردهيد و در منوی ظاهر شده، گزينه ی Accessories را انتخاب کنيد. 

۳ــ در منوی ظاهر شده روی  Calculator کليک راست کنيد. 
۴ــ در منوی ظاهرشده روی گزينه ی Create Short  cut کليک کنيد. 

درس سوم

بيشت که  برنامه هايی  يا  فايل ها  ه ها، 

کار با ويندوز (٣) 



١٥

به اين ترتيب يک گزينه  به نام Calculator (۲) به انتهای اين منو اضافه می شود. 

۵ــ با نگه داشتن کليد چپ ماوس روی گزينه ی ايجاد شده وکشيدن و رها کردن آن روی Desktop، اين Short   cut را 
به روی Desktop منتقل کنيد. 



١٦

۶ــ به روش فوق برای هريک از برنامه های  Paint و Wordيک Short  cut روی Desktop ايجاد کنيد.

(Search) فعّاليّت ۲: جست  وجوی فايل يا پوشه در ويندوز

نكته 
• گاهی محل فايل يا پوشه ای را كه قبلاً در رايانه ذخيره شده، نمی دانيد. برای دسترسی به آن لازم است 
در حافظه ی رايانه ی خود جست  وجو كنيد. با استفاده از امكان Search در ويندوز می توانيد محل فايل يا پوشه ی 

مورد نظر را پيدا كنيد.

فايل «طراحی» راکه قبلاً ايجاد کرده ايد، پيدا کنيد.
روش کار: 

۱ــ روی دکمه ی Start کليک کنيد. 
۲ــ در منوی ظاهر شده روی گزينه ی Search کليک کنيد. 



١٧

به اين ترتيب پنجره ی Search باز می شود. 
۳ــ در کادر سمت چپ پنجره، روی گزينه ی All Files and Folders  کليک کنيد. 

۴ــ در کادر ظاهر شده در قسمت All or part of the file name کلمه ی «طراحی» را تايپ کنيد. 
۵ــ روی کليد Search کليک کنيد. 



١٨

به اين ترتيب عمل جست وجوی فايل «طراحی»، در رايانه ی شما انجام می شود. 
۶ــ در پايان ،آيکون فايل يافته شده در سمت راست پنجره مشاهده می شود. شما می توانيد با دوبار کليک روی 

آيکون فايل مورد نظر، به آن دسترسی داشته باشيد. 

۷ــ به روش فوق پوشه ی class را پيدا کنيد. 

تمرين



١٩

Desktop فعّاليّت ۱: تغيير تصوير زمينه ی

تصوير زمينه ی Desktop رايانه ی خود را تغييردهيد. 
روش کار: 

۱ــ در قسمت خالی Desktop کليک راست کنيد. 
۲ــ از منوی ظاهرشده گزينه ی Properties را انتخاب کنيد. 

درس چهارم

Desktop ی

کار با ويندوز (٤) 



٢٠

۳ــ در بالای پنجره ی ظاهرشده، روی کلمه ی Desktop کليک کنيد. 
۴ــ در کادر: Background روی نام يکی از تصاوير کليک کنيد. 

۵ــ روی دکمه ی Ok کليک کنيد.  

به اين ترتيب تصويرانتخابی شما زمينه ی Desktop  خواهد شد. 
۶ــ اين  فعّاليّت را تکرارکنيد و تصاوير ديگری را برای زمينه ی Desktop انتخاب      کنيد. 



٢١

فعّاليّت ۲: تنظيم ساعت و تاريخ رايانه 

ساعت و تاريخ رايانه ی خود را با ساعت فعلی و تاريخ روز تنظيم کنيد. 
روش کار: 

۱ــ در پايين صفحه ی Desktop مطابق شکل روی قسمتی که ساعت را نشان می دهد دوبار کليک کنيد تا پنجره ی 
مربوط به تنظيم تاريخ و ساعت باز شود. 

۲ــ در بالای پنجره روی Date & Time کليک کنيد. 



٢٢

۳ــ مطابق شکل روی کادر مربوط به زمان (Time) کليک کنيد و عدد مربوط به ساعت فعلی را با راهنمايی مربی 
تنظيم کنيد. 

۴ــ روی دکمه ی  Ok کليک کنيد. 
به تغيير ساعت پايين صفحه ی Desktop توجه کنيد. 



٢٣

بيشتر بدانيد 

شما می توانيد تاريخ سيستم را نيز مانند ساعت تنظيم کنيد . برای اين کار مراحل زير را انجام دهيد. 
مطابق شكل روی كادر مربوط به تاريخ (Date) كليک كنيد و سال ميلادی، ماه و روز را با راهنمايی 

مربی تنظيم كنيد.



٢٤

۱ــ يک Short cut برای برنامه ی Power Point روی Desktop ايجاد کنيد.

راهنمايی: برنامه ی  PowerPoint را از مسير زير پيدا کنيد: 
(Start → All Porgrams → Microsoft Office  → Microsoft Office Power Point)

۲ــ پوشه ی «تمرين» را با استفاده از امکان Search در ويندوز پيدا کنيد. 

۳ــ محتوای پوشه ی «تمرين» را مشاهده کنيد. 

۴ــ تصوير زمينه ی Desktop را به دلخواه تغيير دهيد. 

۵ــ زمان رايانه ی خود را تغيير دهيد. 

Desktop ايجاد کنيد. روی Power Point برای برنامه یt Short cut ــ يکt ۱ort cut يک tــ ۱



٢٥

 
فعّاليّت ۱ (يادآوری): استفاده از امکانات Word برای تهيه ی يک اطلاعيه 

در محيط Word يک اطلاعيه مطابق شکل زير تهيه کنيد: 

درس پنجم

ک ا ا کا ا ا فا ا

((۱۱) ) WordWord کار با برنامه ی کار با برنامه ی

روش کار:
۱ــ برنامه ی Word را از مسير زير اجرا کنيد: 

Start → All Programs →Microsoft office  → Microsoft office Word



٢٦

۲ــ در نوار ابزار ترسيم (Drawing) در پايين پنجره ی Word روی علامت    کليک کنيد. 

۳ــ در کادر ظاهر شده يکی از جلوه های ويژه را انتخاب کرده و روی دکمه ی OK کليک کنيد. 



٢٧

۴ــ در پنجره ی ظاهر شده عبارت «اطلاعيه» را تايپ کرده و روی کليد OK کليک کنيد. 

به اين ترتيب اين عبارت با جلوه ی تعيين شده روی صفحه مشاهده می شود. 
۵ــ روی عبارت «اطلاعيه » کليک کنيد تا نوار ابزار WordArt ظاهر شود.



٢٨

۶ــ  در اين نوار ابزار ، روی علامت    کليک کنيد. 
۷ــ در منوی ظاهرشده روی گزينه ی Square کليک کنيد. 

به اين ترتيب علامت هايی دور عبارت ظاهر می شود . 
در  يا  يا   يا شکل به  ماوس  نشانگر   ، ها   علامت  اين  از  يک  هر  روی  ماوس  نشانگر  داشتن  نگه  با  ۸ــ 

می آيد. با کشيدن اين علامت ها روی صفحه، عبارت را به اندازه ی دلخواه تغيير دهيد.



٢٩

۹ــ برای نوشتن متن اطلاعيه در زير اين عبارت ، درابتدای سطر دو بار کليک کنيد . 
 ۱۰ــ خط اول متن را با قلم Titr و اندازه ی ۱۸ تايپ کنيد.
۱۱ــ با انتخاب علامت   عبارت را وسط چين کنيد. 
۱۲ــ بقيه ی متن را با قلم Zar و اندازه ی ۱۶ تايپ کنيد. 
 ۱۳ــ با انتخاب علامت    متن را راست چين کنيد. 

۱۴ــ فاصله ی بين خطوط متن را به اندازه ی ۱/۵ برابرکنيد. 
برای اين کار متن را انتخاب کنيد و در بالای صفحه ی Word، روی علامت  در دکمه ی  کليک کرده و 

عدد ۱/۵ را انتخاب کنيد. 

۱۵ــ خط آخر را انتخاب کرده و با کليک روی  علامت  آن را چپ چين کنيد. 
۱۶ــ فايل را به نام «اطلاعيه» ذخيره کنيد. 

File → Save As → File name :اطلاعيه → Save  

٢٩٢٩

نكته 
• برای فايل های متنی Word، پسوند doc به صورت پيش فرض تعيين می شود.

• فايل های متنی را کـه شما ايجـاد می کنيد، هنگام ذخيره کـردن به طـور پيش فرض در پوشه ی 
MyDocuments ذخيره می شوند.



٣٠

فعّاليّت ۲: درج و تنظيم تصوير در صفحه 
يک تصوير در فايل «اطلاعيه» درج کنيد و آن را در اندازه و محل مناسب قراردهيد. 

روش کار:
 Insert ۱ــ فايل «اطلاعيه» را باز کرده ، در سطر جديد دو بار کليک کنيد تا مکان نما در آنجا قرار گيرد.  از منوی

در بالای پنجره ی Word گزينه ی Picture را انتخاب کنيد. 
 Word کليک کنيد تا کادر مربوط به آن در سمت راست صفحه ی ClipArt ۲ــ در منوی ظاهر شده روی گزينه ی

باز شود. 



٣١

۳ــ در اين کادر روی کليد Go کليک کنيد تا مجموعه ای از تصاوير ظاهر شود. 

۴ــ روی تصوير دلخواه کليک کنيد.



٣٢

به اين ترتيب تصوير به صفحه ی word منتقل می شود.

۵ــ روی تصوير دوبار کليک کنيد تاپنجره ی Format Picture ظاهر شود. 



٣٣

۶ــ در بالای اين پنجره روی کلمه ی Layout کليک کنيد. 
۷ــ آيکون    را انتخاب کرده و روی دکمه ی OK  کليک کنيد. 

به اين ترتيب علامت هايی مطابق شکل، دور تصوير ظاهر می شود.
۸    ــ با نگه داشتن کليد چپ ماوس روی هريک از اين علامت ها و کشيدن ماوس، تصوير را به اندازه ی دلخواه 

تغيير دهيد. 



٣٤

۹ــ نشانگر ماوس را روی تصوير قرار دهيد تا به شکل  در بيايد. 
۱۰ــ با نگه داشتن کليد چپ ماوس روی تصوير و کشيدن آن، محل تصوير را به دلخواه تعيين کنيد. 

۱۱ــ برای اين که صفحه را به طور کامل مشاهده کنيد روی علامت    در دکمه ی  کليک کنيد تا 
منوی آن باز شود. 

۱۲ــ روی عدد ٪۵۰ کليک کنيد. 
 (File → Save )  .۱۳ــ فايل را ذخيره کنيد



٣٥

(Page Border) فعّاليّت ۱: درج کادر دور صفحه
يک کادر مناسب برای صفحه ی اطلاعيه  تهيه کنيد. 

روش کار
۱ــ فايل « اطلاعيه » را بازکنيد. 

۲ــ در بالای صفحه ی Word روی کلمه ی Format کليک کنيد تا منوی آن ظاهرشود. 
۳ــ در منوی ظاهرشده روی گزينه ی Borders and Shadings کليک کنيد تا پنجره ی مربوط به آن باز شود. 

درس ششم

((٢٢) ) WordWord کار با برنامه ی کار با برنامه ی



٣٦

۴ــ در بالای پنجره ی باز شده، روی عبارت Page Border کليک کنيد.
۵ــ در قسمت Art روی علامت  کليک کنيد تا ليست مربوط به آن باز شود. 

۶ــ نوع کادر را از اين ليست به دلخواه انتخاب کنيد. 

به اين ترتيب در سمت راست پنجره، کادر انتخابی خودرا مشاهده خواهيد کرد.
۷ــ روی دکمه ی OK کليک کنيد. 



٣٧

به اين ترتيب کادر مورد نظرتان دور صفحه ی اطلاعيه درج می شود.

۸   ــ فايل خود را ذخيره کنيد. 

نكته
• برای تعيين نوع كادر به حالت خطی يا نقطه چين، می توانيد در قسمت مربوط به Page Border يكی از 
حالت ها را از ليست Style انتخاب كنيد، سپس با انتخاب رنگ دلخواه در قسمت Color رنگ كادر را تعيين كنيد 

و يا ضخامت آن  را در قسمت :Width تغيير دهيد. 



٣٨

(Bullets and  Numbering) فعّاليّت ۲: شماره گذاری و علامت گذاری متن
متن زير را در انتهای فايل «اطلاعيه» اضافه کنيد: 

روزهای مراجعه ی دانش آموزان به کتابخانه : 
    .  .  .    .  دانش آموزان پايه ی اوّل روز شنبه 

    .  .  .    .  دانش آموزان پايه ی دوم روز دوشنبه 
    .  .  .    .  دانش آموزان پايه ی سوم روز چهارشنبه

مدارک لازم جهت ثبت نام در مسابقه:
۱ــ يک قطعه عکس ۴ * ۳ 

۲ــ کارت عضويت در کتابخانه 
۳ــ فرم درخواست شرکت در مسابقه 

روش کار
۱ــ فايل «اطلاعيه» را بازکنيد. 

۲ــ در انتهای متن با يک بار فشردن کليد Enter يک خط جديد ايجاد کنيد. 



٣٩

۳ــ عبارت «روزهای مراجعه ی دانش آموزان به کتابخانه: » را تايپ کرده و سپس کليد Enter را فشار دهيد. 

۴ــ از منوی Format در بالای پنجره ی Word گزينه ی Bullets and Numbering را انتخاب کنيد. 



٤٠

۵ ــ در بالای پنجره ی ظاهرشده روی کلمه ی Bulleted کليک کنيد. 
۶ــ در اين پنجره يکی از علامت ها را انتخاب کرده و سپس روی دکمه ی OK کليک کنيد. 

به اين ترتيب علامت مورد نظر درابتدای خط ظاهر می شود.
۷ــ عبارت «دانش آموزان پايه ی اول روز شنبه» را تايپ کنيد و سپس کليد Enter را فشاردهيد. 



٤١

۸ ــ دو سطر بعدی را تايپ کنيد (در پايان هر سطر، کليد Enter  را فشار دهيد.)

نكته 
• توجّه داشته باشيد در صورتی كه حالت Bullets and Numbering را انتخاب كرده باشيد، با هر 

بار فشردن كليد Enter علامت مورد نظر به طور خودكار در كنار متن درج می شود. 

۹ــ روی دکمه ی    در بالای پنجره ی  Word  کليک کنيد تا از حالت علامت گذاری خارج شويد.
۱۰ــ عبارت «مدارک لازم جهت ثبت نام در مسابقه:» را تايپ کرده و کليد Enter  را فشار دهيد .

۱۱ــ از منوی Format در بالای پنجره ی Word گزينه ی … Bullets and Numbering را انتخاب کنيد.



٤٢

۱۲ــ در بالای پنجره ی ظاهر شده، روی کلمه ی Numbered کليک کنيد.
۱۳ــ در اين پنجره يکی از حالت های شماره گذاری را انتخاب کنيد و روی دکمه ی OK کليک کنيد.

۱۴ــ سه سطر باقی مانده را تايپ کنيد. (در پايان هر سطر کليد  Enter را فشار دهيد.) توجه داشته باشيد که با هربار 
فشردن کليد Enter، سطر بعدی به طور خودکار شماره گذاری می شود.

۱۵ــ فايل را ذخيره کنيد.



٤٣

۱ــ يک کارت دعوت برای جشن تولد ايجاد کنيد: 

ــ در اين کارت يک تصوير مناسب قرار دهيد. 

ــ عبارت «دعوت نامه» را با يکی از جلوه های ويژه ی Word Art تايپ کنيد و آن را در بالای صفحه 
قرار دهيد. 

ــ متن دعوت نامه را با قلم و اندازه ی دلخواه تايپ کنيد. 

ــ فاصله ی خطوط را دو برابر کنيد. 

ــ يک کادر مناسب برای دور صفحه انتخاب کنيد. 

ــ فايل خود را به نام «دعوت نامه » ذخيره کنيد.

۲ــ يک فايل جديد ايجاد کنيد و ليست لوازم تحرير مورد نياز خود را با استفاده از علامت گذاری 
متن تايپ کنيد.

ــ فايل را به نام « لوازم تحرير» در پوشه ی  « تمرين » در درايو D ذخيره کنيد. 

منتقل   D درايو  در  «تمرين»   پوشه ی  به   My Documents   پوشه ی از  را  نامه»  «دعوت  فايل  ۳ــ 
کنيد. 

کا۱ــ يک کارت دعوت برای جشن تولد ايجاد کنيد:  ک ۱



٤٤

(Table) فعّاليّت ۱: رسم جدول
 جدول برنامه  هفتگی کلاس خود را در محيط Word رسم کنيد. 

روش کار
۱ــ پنجره ی Word را باز کنيد و از منوی Table در بالای پنجره ی Word گزينه ی Insert را انتخاب کنيد. 

۲ــ از منوی ظاهر شده گزينه ی Table را انتخاب کنيد. 

درس هفتم

((٣٣) ) WordWord کار با برنامه ی کار با برنامه ی



٤٥٤٥٤٥

کـادر  در  شـده  ظـاهـر  پنـجره ی  در  ۳ــ 
عدد  را  ستون ها  تعداد    Number of columns

۵ تعيين کنيد. 
تعداد   Number of rows کادر  در  ۴ــ 

سطرها را عدد ۷ تعيين کنيد. 
۵ــ روی دکمه ی OK کليک کنيد. 

به اين ترتيب يک جدول با ۵ ستون و ۷ سطر ايجاد می شود.

نكته 
• برای تايپ عبارت در داخل هريک از خانه های جدول، ابتدا در آن خانه كليک كنيد.



٤٦

۶ــ در سطر اول جدول،  عبارت های زير را به ترتيب در هر         يک از خانه ها تايپ کنيد:  

نكته 
• درصورتی كه اندازه ی خانه ی جدول متناسب با متن داخل آن نباشد، می توانيد نشانگر ماوس را روی 
دربيايد. سپس با نگه داشتن کليد چپ ماوس و كشيدن آن، اندازه ی  خط های جدول قرار دهيد تا به شکل   

خانه ی جدول را تغيير دهيد. 

روزهای هفته ــ زنگ اول ــ زنگ دوم ــ زنگ سوم ــ زنگ چهارم



٤٧

۷ــ در سطردوم جدول دراولين خانه، کلمه ی «شنبه» را تايپ کنيد. 
۸ ــ نام روزهای ديگر هفته را مطابق شکل در خانه های ستون اول جدول تايپ کنيد. 

 ۹ــ خانه های خالی جدول را مطابق برنامه  هفتگی کلاس خود تايپ کنيد. 
۱۰ــ جدول را در وسط صفحه قراردهيد. 

نكته 
• برای جابه جا كردن جدول روی صفحه، كافی است نشانگر ماوس را روی گوشه ی سمت راست در بالای 
جدول  قرار دهيد تا به شكل  در بيايد. سپس با نگه داشتن كليد چپ ماوس وكشيدن آن روی صفحه، جدول 

جابه جا می شود.

۱۱ــ فايل خودرا به نام «برنامه هفتگی» ذخيره کنيد. 



٤٨

۱۲ــ فعّاليّت رسم جدول را تکرار کنيد. برای اين کار جدولی مطابق شکل زير رسم کنيد و فايل آن را به نام «ليست 
نمرات» ذخيره کنيد. 
ملاحظاتنمره ی نوبت اول رايانهنام خانوادگینامرديف
خوب۱۹محرابیمحسن۱
متوسط۱۵جمشيدیعليرضا۲
ضعيف۱۲رشيدیبابک۳

فعّاليّت ۲: اضافه کردن ستون به جدول 
در فايل «ليست نمرات» يک ستون با عنوان «نمره ی نوبت دوم رايانه» بعد از ستون «نمره ی نوبت اوّل رايانه» به جدول اضافه 

کنيد. 
 روش کار

۱ــ فايل «ليست نمرات» را بازکنيد. 
۲ــ در ستون «نمره ی نوبت اول رايانه» کليک کنيد. 

۳ــ از منوی Table گزينه ی Insert را انتخاب کنيد. 
۴ــ از منوی ظاهر شده، گزينه ی Columns to the left (ستون در سمت چپ) را انتخاب کنيد.



٤٩

به اين ترتيب يک ستون در سمت چپ ستون فعلی اضافه می شود. 

نكته 
را  زير  مسير  قراردارد،  آن  در  مكان نما  ستونی كه  راست  سمت  در  ستون  يک  كردن  اضافه  برای   •

اجرا كنيد. 
  Table → Insert → Columns to the Right (ستون در سمت راست)

۵ــ عبارت «نمره ی  نوبت دوم رايانه» و نمرات  ۱۸ ، ۱۷ ، ۱۵ را در خانه های اين ستون تايپ کنيد.



٥٠

 فعّاليّت ۳: اضافه کردن سطر به جدول 
يک سطر برای دانش آموزی با مشخصات زير به جدول اضافه کنيد: 

۴ــ علی، احمدی، ۱۷ ، ۱۹ ،  خوب
روش کار

۱ــ در فايل « ليست نمرات» در سطر آخر جدول کليک کنيد. 
۲ــ از منوی Table گزينه Insert را انتخاب کنيد. 

۳ــ از منوی ظاهر شده، گزينه Rows Below  (سطر در پايين) را انتخاب کنيد. 



٥١

به اين ترتيب يک سطر در پايين سطر فعلی اضافه می شود. 

۴ــ مشخصات دانش آموز را در آن وارد کنيد . 
۵ــ فايل را ذخيره کنيد. 



٥٢

فعّاليّت ۴: حذف سطر يا ستون از جدول 
از جدول ليست نمرات ستون «نمره ی نوبت دوم رايانه» و سطر شماره ی ۲ را حذف کنيد. 

روش کار
۱ــ فايل «ليست نمرات» را باز کنيد. 

۲ــ در ستون «نمره ی نوبت دوم رايانه» کليک کنيد. 
۳ــ از منوی Table گزينه ی Delete را انتخاب کنيد. 

۴ــ از منوی ظاهر شده روی گزينه ی Columns کليک کنيد. 
به اين ترتيب ستون «نمره ی نوبت دوم رايانه» حذف می شود. 



٥٣

۵ــ روی رديف شماره ی ۲ در جدول کليک کنيد. 
۶ــ از منوی Table گزينه ی Delete را انتخاب کنيد. 

۷ــ از منوی ظاهر شده، روی گزينه ی Rows کليک کنيد. 

به اين ترتيب سطر شماره ی ۲ حذف می شود. 
۸  ــ شماره  رديف های بعدی را در جدول تصحيح کنيد. 

۹ــ فايل را ذخيره کنيد. 



٥٤

۱ــ جدولی مطابق شکل زير در برنامه ی Word تهيه کنيد:  

جدول برنامه های ايّام دهه ی فجر
ساعتتاريخکلاسموضوعرديف
۱۱ــ ۸٩/۱۱/۱۲۹/۳۰اول الفقرآن، سرود، سخنرانی١
۱۲ــ۸٩/۱۱/۱۴۱٠/۳۰کليه ی کلاس هامسابقه، بازديد از نمايشگاه٢
 ـ ۸٩/۱۱/۱۶٨دوم الفقرآن، سرود، تئاتر٣ ١٠ـ
۱۲ــ ۸٩/۱۱/۱۸۱۰دوم بسرود ، تئاتر٤
۱۲ ــ ۸٩/۱۱/۲۰۱۰کليه ی کلاس هامسابقه ، تئاتر۵

      
۲ــ اندازه ی سطرها و ستون ها را طوری تغيير دهيد که متناسب با متن داخل خانه ها باشد. 

۳ــ يک سطر به آخر جدول اضافه کنيد و عبارت های زير را در خانه های آن وارد کنيد: 

۶ــ سخنرانی و جشن، کليه ی کلاس ها، ۱۱/۲۱/۸٩ ، ۳۰/ ۱۲، ۱/۳۰

کنيد.  تعيين   ۱۲ را  آن  ی  اندازه  و   Titr را  آن  قلم  و  کنيد  انتخاب  را  جدول  اول  سطر  ۴ــ 

۵ــ سطرهای دوم به بعد را انتخاب کنيد و قلم آن را Nazanin و اندازه ی آن را ۱۴ تعيين کنيد. 

۶ــ فايل را به نام «دهه ی فجر» در پوشه ی «تمرين» در درايو D ذخيره کنيد. 

Word تهيه کنيد:  dــ جدولی مطابق شکل زير در برنامه ی ۱ــ جدولی مطابق



٥٥

درس هشتم

((٤٤) ) WordWord کار با برنامه ی کار با برنامه ی

فعّاليّت ۱: استفاده از نوار ابزار ترسيم (Drawing) برای درج شکل همراه با متن 
برای «برنامه  هفتگی» خود يک عنوان مطابق شکل ايجاد کنيد: 

روش کار
۱ــ فايل «برنامه  هفتگی» را بازکنيد. 

۲ــ در نوارابزار ترسيم (Drawing) در پايين پنجره ی Word، روی عبارت Autoshapes کليک کنيد تا منوی آن 
باز شود. 

۳ــ نشانگر ماوس را روی گزينه ی Stars and Banners قراردهيد تا منوی مربوط به آن باز شود. 
۴ــ روی يکی از شکل ها کليک کنيد. 



٥٦

۵ــ در بالای جدول، کليد سمت چپ ماوس رانگه داشته و بکشيد تا شکل در اندازه ی مورد نظر رسم شود. 

۶ــ در شکل، کليک راست کنيد تا منوی مربوط به آن ظاهر شود.
۷ــ در منوی ظاهرشده گزينه ی Add text را انتخاب کنيد. 



٥٧

۸  ــ عبارت «برنامه  هفتگی» را تايپ کنيد. به اين ترتيب عبارت «برنامه  هفتگی» داخل شکل قرار می گيرد.

نكته
• برای تغيير اندازه ی شكل كافی است يک بار روی شكل كليک كنيد تا علامت های دور شكل ظاهر شود. 

سپس با نگه داشتن هر يک از اين علامت ها و كشيدن ماوس، اندازه ی شكل را تغيير دهيد. 
• برای جابه جا كردن شكل روی صفحه كافی است  نشانگر ماوس  را روی شكل قرار دهيد تا به شكل  
 در بيايد. سپس با نگه داشتن كليد چپ ماوس روی شكل و كشيدن آن در مكان دلخواه،  شكل را جابه جا 

کنيد.

۹ــ اندازه و محل شکل را به طور مناسب تعيين کنيد. 
۱۰ــ فايل را ذخيره کنيد. 



٥٨

فعّاليّت ۲: استفاده از نوار ابزار ترسيم (Drawing) برای تغيير رنگ و حالت شکل 
عنوان «برنامه  هفتگی» را به رنگ دلخواه و حالت سه بعدی تغيير دهيد. 

روش کار
۱ــ فايل « برنامه  هفتگی»  را بازکنيد. 

۲ــ روی شکل بالای صفحه، يک بارکليک کنيد تا انتخاب شود.
 ۳ــ در نوارابزار ترسيم ، روی علامت  در دکمه ی    کليک کنيد تا منوی آن باز شود.

۴ــ در منوی ظاهرشده، رنگ دلخواه را انتخاب کنيد. 



٥٩

به اين ترتيب رنگ شکل تغييرمی کند.

نكته 
درنوارابزار ترسيم:

• دكمه ی    برای تغيير رنگ خط دور شكل به كار می رود.

•  دكمه ی   برای تغيير رنگ نوشته ی داخل  شكل به كار می رود.



٦٠

٥ ــ برای ايجاد حالت سه بعدی شکل عبارت« برنامه ی هفتگی»، در نوارابزار ترسيم روی    کليک کنيد تا 
منوی آن باز شود. 

۶ ــ از منوی ظاهر شده، يکی از حالت ها را انتخاب کنيد. 

به اين ترتيب عبارت داخل شکل، حالت سه بعدی پيدا می کند.

٧ــ فايل خود را ذخيره کنيد. 



٦١

(Find and Replace)  فعّاليّت ۱: جست  و جو و جايگزينی در متن
در فايل «اطلاعيه» کلمه ی «کتابخوانی» را پيدا کنيد و به جای آن کلمه ی «کتاب خوانی» را جايگزين کنيد. 

روش کار: 
۱ــ فايل «اطلاعيه» را بازکنيد.

۲ــ در ابتدای متن کليک کنيد. 
۳ــ از منوی Edit گزينه ی   Replace   (جايگزينی) را انتخاب کنيد. 

درس نهم

(Fi d d R l ) ت د ن گز ا

((٥٥) ) WordWord کار با برنامه ی کار با برنامه ی



٦٢٦٢٦٢

۴ــ در پنجره ی ظاهر شده در کادر  Find what،کلمه ی «کتابخوانی» را تايپ کنيد. 
۵ــ در کادر Replace with کلمه ی «کتاب خوانی» را تايپ کنيد. 

۶ــ روی دکمه ی Replace All کليک کنيد.

به اين ترتيب به طور خودکار کلمه ی «کتاب خوانی» درتمام متن جايگزين کلمه ی «کتابخوانی» می شود.
۷ــ فايل را ذخيره کنيد. 

نكته 
• درصورتی که بخواهيد عبارتی را بدون جايگزين در کل متن بيابيد، کافی است در منوی Edit روی گزينه  ی 
 ،Find Next تايپ نماييد. سپس با کليک روی Find what کليک کنيد و عبارت موردنظر خود را در کادر Find

عبارت موردنظر در متن تايپ شده جستجو می شود و موارد يافته شده با رنگ متفاوت در متن مشخص می شود. 



٦٣٦٣٦٣

 (Page Setup) فعّاليّت ۲:  تنظيمات صفحه
شعر زير را تايپ کنيد: 

                                   بنــی آدم اعضای يـکديـگرنــد                    که در آفرينش زيک گوهرند 
                                  چو عضوی به درد آورد روزگار                   دگر عضوهـا را نـماند قـرار

روش کار
۱ــ پنجره ی مربوط به برنامه ی Word را باز کنيد.
۲ــ نوع و اندازه ی قلم را به دلخواه انتخاب کنيد. 

۳ــ عبارت اول شعر را تايپ کنيد و دو بار کليد   را فشار دهيد تا فاصله ی کافی ايجاد شود. 

نكته 
• برای ايجاد فاصله بين عبارت ها می توانيد از كليد   روی صفحه كليد استفاده كنيد.



٦٤

۴ــ عبارت  دوم را تايپ کرده و کليد Enter را فشاردهيد تا نشانگر به خط بعدی منتقل شود. 

۵ــ به روش فوق عبارت های خط دوم را تايپ کنيد.
۶ــ از منوی File گزينه ی Page Setup را انتخاب کنيد. 



٦٥

و   ۳ cm را   (Bottom) پايين  و   (Top) بالا  حاشيه های  شکل،  مطابق   Margins قسمت  در  مربی  کمک  به  ۷ــ  
حاشيه های چپ (Left) و راست (Right) صفحه را cm ۲ تعيين کنيد. 

۸  ــ روی دکمه ی  OK کليک کنيد. 

به اين ترتيب حاشيه های صفحه به اندازه ی تعيين شده درمی آيد.
۹ــ مراحل ۶ تا ۸ را تکرارکنيد و حاشيه های صفحه را به دلخواه تغييردهيد و نتيجه ی آن را مشاهده کنيد. 

۱۰ــ فايل را با نام « شعر» ذخيره کنيد. 



٦٦

۱ــ فايل «دهه ی فجر» را باز کنيد. 

۲ــ ستون «رديف» را انتخاب کنيد و آن را وسط چين کنيد. 

۳ــ ستون «موضوع برنامه» را انتخاب کنيد و آن را راست چين کنيد. 

۴ــ ستون «تاريخ» و «کلاس» و « ساعت»  را انتخاب کنيد و آن ها را چپ چين کنيد. 

۵ــ با استفاده از امکان جست و جو و جايگزينی (Find and Replace) به جای کلمه ی «تئاتر»،کلمه ی 
«نمايش» را جايگزين کنيد. 

عبارت  و  انتخاب کنيد  مناسب  شکل  يک   ،(Drawing) ترسيم  نوارابزار  از  استفاده  با  ۶ــ 
«برنامه های دهه ی فجر» را در آن تايپ کنيد. 

۷ــ شکل را در بالای جدول در محل مناسب قراردهيد و رنگ آن را به دلخواه تغيير دهيد. 

۸ــ حاشيه های صفحه را مطابق زير تعيين کنيد: 
 ٣ cm (Bottom) حاشيه ی پايين   ۲/۵ cm   (Top) حاشيه ی بالا
٢ cm (Right) حاشيه ی راست   ٢ cm (Left) حاشيه ی چپ

۹ــ با استفاده از Print Preview پيش نمايش چاپ را مشاهده کنيد. 

۱۰ــ فايل را ذخيره کنيد. 

ل۱ــ فايل «دهه ی فجر» را باز کنيد.  فا ۱



٦٧

درس دهم

فرض کنيد، می خواهيد مانند يک معلم، مطالبی را به دانش آموزان آموزش دهيد. شما می توانيد با کمک  برنامه ی 
Power Point اسلايدهای مختلفی را که شامل متن، تصوير و يا حتی صدا باشد، طراحی کنيد و آن ها را برای دانش آموزان 

نمايش دهيد. به اين ترتيب شما می توانيد مطالب مورد نظر را بهتر ارائه کنيد. 
يک  محصولات  معرّفی  تحقيقی،  کار  يک  ارائه ی  برای  مثلاً  دارد.  مختلفی  کاربردهای   Power Point برنامه ی 

کارخانه، معرّفی فعّاليّت های يک مؤسسه يا برای آموزش يک موضوع درسی می توانيد از اين برنامه استفاده کنيد.

د آموزش دانشآموزان به را مطال ، معل يک مانند د خواه م د، کن

Power Point آشنايی با برنامه ی



٦٨

فعّاليّت ۱: اجرای يک فايل در برنامه ی Power Point و مشاهده ی امکانات آن 
فايل  nemuneh را از روی CD اجراکرده و امکانات آن را بررسی کنيد. 

روش کار: 
۱ــ با راهنمايی مربی خود، CD فايل های برنامه ی Power Point را که مربوط به کتاب است، داخل درايو قرار 

دهيد. 
۲ــ از مسير زير فايل nemuneh را پيدا کنيد. 

   My Computer  → CD درايو مربوط به →  nemuneh .ppt



٦٩

۳ــ روی درايو مربوط به CD دو بار کليک کنيد.

۴ــ روی فايل مورد نظر دو بار کليک کنيد تا اجرا شود.



٧٠

۵ــ  روی دکمه ی   در پايين صفحه کليک کنيد.
به اين ترتيب فايل مورد نظر نمايش داده می شود. 

۴ــ کليد Enter را فشاردهيد تا صفحه های بعدی را مشاهده کنيد. 
۵ــ پس از مشاهده ی آخرين صفحه، کليد Esc روی صفحه کليد را فشار دهيد تا برنامه از حالت نمايش اسلايدها 

خارج شود. 
۶ــ پنجره ی برنامه ی Power Point را ببنديد. 

به روش فوق سايرفايل های Power Point روی CD را اجرا کنيد و آن ها را نمايش دهيد. 
به نظر شما برنامه ی Power Point چه کاربردهای ديگری دارد؟ 

نكته 
• پسوند فايل های ايجاد شده در برنامه ی Power Point  به صورت پيش فرض  ppt  است.



٧١

فعّاليّت ۱: ايجاد يک فايل در برنامه ی Power Point، درج متن، نمايش اسلايد
يک فايل نمايشی به نام «گياهان» ايجاد کنيد و در آن عبارت « عوامل مهم برای رشد گياهان » را درج کنيد.   

روش کار: 
۱ــ برنامه ی Power Point را اجرا کنيد. 

برای اين کار می توانيد روی آيکون  اين برنامه که روی Desktop قراردارد دو بار کليک کنيد يا برنامه را از مسير 
زير اجرا کنيد: 

Start → All Programs → Microsoft Office → Microsoft Office Power Point

درس يازدهم

نمايش متن، درج ،Power Point برنامهی در فايل يک ايجاد :۱ فعّاليّت

(۱) Power Point کار با برنامه ی



٧٢

به اين ترتيب پنجره ی Power Point به شکل زير باز می شود و يک اسلايد خالی در صفحه کاری مشاهده می شود. 

نكته
• به صفحه ی كاری در برنامه ی Power Point، «اسلايد» می گويند. 

همان طور که مشاهده می کنيد، در اين اسلايد دو کادر وجود دارد.   



٧٣

۲ــ روی کادر بالا کليک کنيد و عبارت « به نام خدا » را تايپ کنيد. 
(در صورتی که زبان صفحه کليد فارسی نبود، کليدهای Alt و Shift را همزمان فشار دهيد.) 

۳ــ روی کادر پايين کليک کنيد و عبارت «عوامل مهم برای رشد گياهان» را تايپ کنيد. 



٧٤

۴ــ عبارت «به نام خدا» يا کادر مربوط به آن را انتخاب کرده و اندازه و نوع قلم  آن را به دلخواه تعيين کنيد. 
۵ــ  نشانگر ماوس را روی کادر بالا طوری قرار دهيد که به شکل  در بيايد. حال با نگهداشتن کليد چپ 

ماوس و کشيدن آن، کادر را مطابق شکل در بالای اسلايد قرار دهيد.

۶ــ به روش فوق کادر پايين را در وسط اسلايد قرار دهيد و اندازه و نوع قلم آن را تعيين کنيد. 



٧٥

۷ــ برای نمايش اسلايد، روی علامت    درپايين پنجره ی Power Point کليک کنيد. 
۸  ــ برای خارج شدن از حالت نمايشی، کليد Esc روی صفحه کليد را فشار دهيد. 

۸ــ فايل را به نام « گياهان»  ذخيره کنيد. 

فعّاليّت ٢: اضافه کردن اسلايد  
يک اسلايد به فايل « گياهان » اضافه کنيد و در آن عوامل مهم برای رشد گياهان را درج کنيد و سپس آن را نمايش 

دهيد. 
روش کار: 

برای اين که مطالب مورد نظر خود را در اسلايدهای بعدی وارد کنيد ، لازم است يک اسلايد جديد بسازيد. 
۱ــ در فايل «گياهان» از منوی Insert گزينه ی New Slide را انتخاب کنيد. 

به اين ترتيب، يک اسلايد بعد از اسلايد فعلی اضافه می شود. 



٧٦

نكته
• در صورتی که بخواهيد يک اسلايد را حذف کنيد، می توانيد با کليک روی اسلايد مورد نظر در ليست 

اسلايدها، آن را انتخاب کنيد سپس از منوی Edit  روی گزينه ی Delete Slide کليک كنيد.

۲ــ در اسلايد دوم ، روی کادر بالای صفحه کليک کنيد و عبارت «عوامل مهم برای رشد گياهان» را تايپ کنيد. 
۳ــ در کادر دوم عبارات زير را تايپ کنيد: ( اندازه و نوع قلم را به دلخواه تعيين کنيد) 

• نور 
• دما 
• آب 

• خاک 
• کود

(برای تنظيم صفحه از راست به چپ ، روی کليد   در نوارابزار بالای صفحه کليک کنيد. ) 

١ــ در صورتی که کليد   در نوار ابزار موجود نباشد. مربی آن را به نوار ابزار اضافه کند.



٧٧

۴ــ با فشردن کليد Page Up به اسلايد قبلی رويد. 

نكته
• برای نمايش اسلايد بعدی می توانيد از كليد  Page Down نيز استفاده كنيد.

۵ــ برای نمايش اسلايدها روی علامت   کليک کنيد. 
۶ــ در حالت نمايشی برای مشاهده ی اسلايد بعدی، کليد Enter را فشاردهيد يا روی اسلايد کليک کنيد. 

۷ــ کليد Esc را فشاردهيد تا از حالت نمايشی خارج شويد. 
۸  ــ فايل را ذخيره کنيد. 

۹ــ از برنامه ی Power Point خارج شويد. 



٧٨

 (Back ground) فعّاليّت ۱: تغيير زمينه ی اسلايد
  در فايل «گياهان »، زمينه ی مناسبی برای اسلايدها تعيين کنيد. 

روش کار
  ۱ــ برنامه ی Power Point را اجرا و فايل «گياهان» را بازکنيد.         

۲ــ از منوی Format گزينه ی Background را انتخاب کنيد تا پنجره ی مربوطه باز شود. 

درس دوازدهم

 (Back ground) فعّاليّت ۱: تغيير زمينه ی اسلايد

(٢) Power Point کار با برنامه ی



٧٩

علامت     روی  ظاهرشده  پنجره ی  در  ۳ــ 
مطابق شکل کليک کنيد تا منوی مربوط به آن باز 

شود.
٤ــ روی گزينه ی … Fill Effects  کليک 

کنيد تا پنجره ی آن باز شود. 

٥  ــ در بالای پنجره روی texture کليک 
کنيد. 

دلخواه  به  را  زمينه ها  از  يکی  ۶ــ 
انتخاب کنيد و روی کليد OK کليک  کنيد تا به 

پنجره ی قبلی ( Back ground  ) برگرديد.



٨٠

 ۷ــ روی کليد Apply کليک کنيد. تا زمينه ی مورد نظر شما برای اسلايد فعلی تعيين شود. 

۸ــ با کليد Page Down به اسلايد دوم برويد.زمينه ی مناسبی برای اين اسلايد تعيين کنيد.

۹ــ فايل را ذخيره کنيد. 

نكته
تمام  برای  نظر  مورد  زمينه ی  كنيد،  كليک   Apply to All كليد  روی   Back ground پنجره ی  در  اگر   •

اسلايد ها تعيين می شود.  
• شما می توانيد زمينه ی اسلايدهای خود را يكی از زمينه های آماده برنامه ی Power Point قرار دهيد. 
برای اين كار از منوی Format گزينه ی Slide design  را انتخاب كنيد، تا پنجره ی مربوط به آن در كنار اسلايد 

فعلی ظاهر شود و سپس از ليست زمينه های آماده، يكی را انتخاب كنيد.



٨١

فعّاليّت ۲:  تغيير رنگ قلم متن ــ تغيير زمينه ی متن در اسلايد 
در فايل «گياهان»، رنگ و زمينه ی مربوط به عبارت های نوشته شده را تغيير دهيد. 

روش کار: 
۱ــ فايل «گياهان» را باز کنيد. 

۲ــ  در اسلايد اول، کادر «به نام خدا» را انتخاب کنيد. 
۳ــ  در نوارابزار Drawing روی علامت  در دکمه ی    کليک کنيد تا منوی آن ظاهر شود.

۴ــ در منوی ظاهر شده روی … More Colors کليک کنيد تا پنجره ی آن باز شود. 



٨٢

۵ــ يکی از رنگ ها را انتخاب کرده و روی OK کليک کنيد. 
به اين ترتيب رنگ قلم عبارت «به نام خدا» تغيير می يابد.

 ۶ــ به روش مشابه رنگ قلم عبارت «عوامل مهم برای رشد گياهان» را به دلخواه تغيير دهيد. 



٨٣

ابزار  نوار  در  کادر  اين  تغييرزمينه ی  برای  شود.  انتخاب  تا  کنيد  کليک  بالا  کادر  روی  دوم  اسلايد  در  ۷ــ 
Drawing در پايين صفحه، روی علامت   در دکمه ی   کليک کنيد. 

۸  ــ در منوی ظاهر شده روی گزينه ی … Fill Effects کليک کنيد.

۹ــ در پنجره ی ظاهر شده می توانيد يکی از حالت ها را انتخاب کنيد. 
۱۰ــ برای اين که ترکيبی از رنگ های متنوع را انتخاب کنيد، روی Gradient در بالای پنجره کليک کنيد.

۱۱ــ در قسمت Colors  يکی از گزينه ها را انتخاب کرده و از کادرهای مقابل آن مطابق شکل يکی از رنگ ها را 
انتخاب کنيد.

۱۲ــ  از کادر Shading styles يکی از حالت ها را انتخاب کنيد.



٨٤

۱۳ــ  روی کليد OK کليک کنيد. 
 به اين ترتيب زمينه ی کادر بالايی در اسلايد دوم تغيير می کند. 

۱۴ــ به روش فوق زمينه ی مناسبی برای کادر پايين صفحه نيز تعيين کنيد. 
۱۵ــ فايل خود را ذخيره کنيد. 

نكته
دكمه ی                 در  علامت     روی  كليک  با  می توانيد  كادر،  زمينه ی  رنگ  تعيين  برای   •
دلخواه  به  را  رنگ ها  از  يكی   ،Colors پنجره ی  در  و  كرده  انتخاب  را    More Fill Colors گزينه ی … 

انتخاب و روی كليد OK كليک كنيد. 

۱۶ــ از برنامه ی Power Point خارج شويد. 



٨٥

فعّاليّت ۱: درج تصوير از ClipArt در اسلايد
در فايل «گياهان» اسلايدهايی برای عوامل «نور» و «گرما» همراه با تصوير ايجاد کنيد.   

روش کار: 
۱ــ برنامه ی Power Point  را اجرا کنيد. 

۲ــ فايل «گياهان» را باز کنيد. 
۳ــ با فشردن کليد Page Down  به اسلايد دوم برويد. 

  Insert → New Slide .۴ــ دو اسلايد جديد ايجاد کنيد

درس سيزدهم

اسلايد در ClipArt از تصوير درج :۱ فعّاليّت

(٣) Power Point کار با برنامه ی



٨٦٨٦٨٦

۵ــ در اسلايد سوم عبارت «نور» را در کادر بالای صفحه تايپ کنيد. 

۶ــ در کادر دوم متن زير را تايپ 
کنيد:

زياد  نور  به  گياهان  از  بعضی    •
احتياج دارند. 

کمی  نور  به  گياهان  از  بعضی   •
احتياج دارند. 

آن ها  نوع  به  توجه  با  گياهان   •
مختلف  نورهای  با  مکان هايی  در  بايد 

نگه داری شوند. 

نكته
•  بهتر است هر چند دقيقه يک بار فايل خود را ذخيره كنيد. برای اين كار روی علامت   در بالای 

پنجره كليک كنيد يا از منوی File گزينه ی Save را انتخاب كنيد. 



٨٧

۷ــ برای درج تصوير در اين اسلايد از منوی  Insert  گزينه ی Picture را انتخاب کنيد. 
٨  ــ در منوی ظاهر شده روی گزينه ی Clip Art کليک کنيد. 

به اين ترتيب مطابق شکل پنجره ی Clip Art در کنار اسلايد ظاهر می شود. 
٩ــ روی کليد Go  در پنجره ی Clip Art کليک کنيد. 

به اين ترتيب فهرستی از تصاوير موجود در Clip Art مشاهده می شود. 



٨٨

۱۰ــ در پنجره ی Clip Art روی تصوير دلخواه کليک کنيد تا روی اسلايد کپی شود. 

۱۱ــ در اسلايد، روی اين تصوير کليک کنيد تا نشانگر ماوس به شکل  در بيايد، سپس اندازه و محل تصوير 
را در اسلايد تنظيم کنيد. 

۱۲ــ با فشردن کليد Page Down به اسلايد چهارم برويد. 



٨٩

۱۳ــ در اسلايد چهارم در کادر بالا عبارت « دما» را تايپ کنيد. 
۱۴ــ در کادر پايين متن زير را تايپ کنيد: 

• بعضی از گياهان به هوای خنک احتياج دارند.

• بعضی از گياهان به هوای معتدل احتياج دارند.
• بعضی از گياهان به هوای گرم احتياج دارند.

۱۵ــ به روش قبل تصوير مناسبی را از Clip Art انتخاب کرده و در اين اسلايد درج کنيد. 

۱۶ــ فايل را ذخيره کنيد. 
۱۷ــ از محيط Power Point خارج شويد. 



٩٠

درس چهاردهم

(٤) Power Point کار با برنامه ی

فعّاليّت ۱: درج تصوير از CD در اسلايد 
يک فايل نمايشی به نام «حيوانات» ايجادکنيد و تصاوير انواع مختلف حيوانات (پرندگان، پستانداران، خزندگان، 

ماهی ها، دوزيستان ) را در آن درج کنيد. 
روش کار:

۱ــ برنامه ی Power Point را از مسير زير اجرا کنيد:  
Start → All Porgrams → Microsoft Office → Microsoft office Power Point 

۲ــ برای درج تصوير از CD در اسلايد، ابتدا CD را داخل درايو مربوطه قراردهيد. 
۳ــ از منوی Insert گزينه ی Picture را انتخاب کنيد. 

۴ــ از منوی ظاهر شده گزينه ی …From File را انتخاب کنيد. 



٩١

۵ــ در پنجره ی ظاهر شده در کادر: look in درايو مربوط به CD را انتخاب کنيد. 
به اين ترتيب محتويات CD مشاهده می شود. 

۶ــ روی پوشه ی «حيوانات» دو بار کليک کنيد. 

، گزينه ی  ۷ــ برای مشاهده ی هريک از تصاوير موجود در پوشه  مطابق شکل از منوی مربوط به آيکون 
Thumbnails را انتخاب کنيد. 



٩٢

۸  ــ يک تصوير از پرندگان انتخاب کرده و روی دکمه ی Insert  کليک کنيد. 
به اين ترتيب تصوير مورد نظر شما در اسلايد درج می شود. 

۹ــ اندازه ی تصوير را به دلخواه تغيير دهيد.



٩٣

(Insert → New Slide) .۱۰ــ  يک اسلايد جديد به فايل اضافه کنيد
۱۱ــ با تکرار مراحل ۳ تا ۹ يک تصوير از پستانداران در اسلايد دوم درج کنيد. 

۱۲ــ سه اسلايد جديد ديگر اضافه کنيد و در هر اسلايد به ترتيب يک تصوير از خزندگان، دوزيستان و ماهی ها مطابق 
روش بالا درج کنيد. 

۱۳ــ فايل خود را به نام «حيوانات» ذخيره کنيد. 
File → Save As → File Name :حيوانات →  Save

۱۴ــ کليد Ctrl و Home را در صفحه کليد همزمان فشار دهيد تا به اسلايد اول برويد. 
۱۵ــ برای نمايش اسلايدها ، روی  آيکون   در پايين پنجره ی Power Point کليک کنيد.

 ۱۶ــ با هر بار کليک ماوس يا فشردن کليد Enter اسلايدهای بعدی را مشاهده کنيد. 
۱۷ــ با فشردن کليد Esc از حالت نمايش اسلايدها خارج شويد. 



٩٤

۱ــ فايل «گياهان» را باز کنيد. 

۲ــ سه اسلايد مربوط به عوامل « آب »، « خاک» و«کود» اضافه کنيد. سپس متن های زير را برای 
هريک تايپ کنيد:      

«آب»
• مواد غذايی همراه آب از طريق ريشه جذب گياه می شود. 

• کمبود آب، موجب پژمردگی و ريزش برگ های گياه می شود. 
• آب زياد باعث پوسيدگی ريشه می شود. 

«خاک»
• خاک مناسب برای گلدان، مخلوطی از خاک باغچه و ماسه است.

«کود»
• خاک، همه ی مواد لازم برای رشد مناسب گياه را ندارد. 

• لازم است با  کود دادن، خاک را تقويت کرد. 

۳ــ اندازه و رنگ قلم متن ها را به دلخواه تغيير دهيد. 

۴ــ برای اسلايد های سوم تا هفتم زمينه های مناسب (Back ground) انتخاب کنيد. 

۵ــ برای اسلايد  پنجم تصوير مناسب از ClipArt درج کنيد. 

٦ــ برای اسلايد  پنجم تصوير مناسب از روی CD درج کنيد.

۷ــ در اسلايد های سوم تا هفتم برای کادر هريک از عناوين، زمينه ی دلخواه تعيين کنيد. 

اهان۱ــ فايل «گياهان» را باز کنيد.  «گ ل فا ۱



٩٥

بيشتر بدانيد 

 CD نحوه ذخيره کردن اطلاعات روی
برای اين که اطلاعات را از هارد ديسک رايانه ی خود روی CD کپی کنيد، لازم است رايانه ی  شما 

.( CDWriter يعنی) باشد CD مجهز به درايو مخصوص نوشتن روی
 Copy – Paste استفاده از فرمان ،CD يکی از روش های ساده برای کپی کردن اطلاعات برروی 

است. برای اين کار مراحل زير را انجام دهيد:
١ــ ابتدا فايل ها و پوشه های مورد    نظر خود را انتخاب  کنيد.

٢ــ همزمان کليدهای Ctrl  و C  را فشار دهيد.
٣ــ در پوشه ی My Computer روی آيکون مربوط به CD کليک کنيد تا پنجره ی آن بازشود.

٤ــ همزمان کليدهای Ctrl و V را فشار دهيد تا اطلاعات به داخل CD کپی شود. به اين ترتيب يک 
تصوير از فايل ها و پوشه های موردنظر روی CD ايجاد می شود.

٥ــ در کادر سمت چپ پنجره ی ظاهر شده، روی گزينه ی Write these files to CD کليک  کنيد. 
به اين ترتيب فايل های مورد نظر  شما روی CD کپی می شود. 



٩٦

Office جدول کليدهای ميانبر در نرم افزارهای

عملکرد کليدهاکليدهای ميانبر
Ctrl+z(Undo) لغو آخرين عمل انجام شده
Ctrl+y(Redo) Undo لغوعمل
Ctrl+c(Copy)کپی
Ctrl+x(Cut) انتقال
Ctrl+v(Paste) چسباندن
Ctrl+A(Select All) انتخاب کل
Ctrl+F(Find) جستجو کردن
Ctrl+H(Replace) جايگزين کردن
Ctrl+Gرفتن به صفحه ی مورد نظر در يک فايل
Ctrl+N(New) ايجاد فايل جديد
Ctrl+O(Open) باز کردن فايل 
Ctrl+S(Save) ذخيره کردن فايل
Ctrl+P(Print) چاپ فايل

Ctrl+Homeرفتن به ابتدای فايل
Ctrl+Endرفتن به انتهای فايل
Alt + F۴(Close) بستن فايل

F١(Help) مشاهده ی نرم افزار
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